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まえがき

FactSage Education は FactSage の機能制限版です。教育機関での利用を想定
していますが、どなたでも無料で FactSage の基本機能を試すことができます。

FactSage Education による手軽な数値実験は、「化学熱力学」や「状態図」をより
深く理解する助けとなるはずです。

この資料では FactSage Education Package のインストール手順と、熱力学平衡
計算に使われる Equilib アプリ、それから状態図計算に使われる Phase Diagram 

アプリの基本操作を説明します。

FactSage と熱力学平衡計算の世界にようこそ！

RCCM FactSage サポートチーム
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1.  FactSage Education Package
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FactSage Education Package

FactSage Education Package は FactSage の機能制限版である。
インターネットに接続していれば使用可能である。無料であり、教育
機関での利用を想定している。

平衡計算、
状態図計算
などで、計
算できる元
素数は、最
大で 3 元素
まで

機能制限の一
覧（次ページ）

有効期限
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FactSage Education Package

• Reaction, EpH, Predom, Equilib, Phase 

Diagram: 最大で 3 元素まで入力できる
• Equilib と Phase Diagram は同時起動不可
• ChemSage ファイルの入出力は不可
• TDB ファイルの変換は不可
• OptiSage, Calphad Optimizer, Results, 

Viscosity は利用不可
• Macro, アドオン(Add-on) は利用不可
• ChemApp for Python は利用不可
• サーバー版・クライアント版は存在しない
• パソコンは www.factsage.com にアクセスできな
ければならない

• 起動時に、www.factsage.com にアクセスしていく

つかのテキストファイルをダウンロードする。ダウン
ロードができるようにセキュリティの設定が必要な
場合がある

• お使いのパソコンからファイルをアップロードするこ
とはない

• 有効期限は 2024 年 6 月 30 日である。新バー

ジョンがリリースされない場合は延長される見込み
（新しいバージョンがリリースされた場合はそちらを
使ってほしい）。
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FactSage Education の熱力学データベース

付属する熱力学データベースの一覧
名前 利用用途

FactPS 化合物、希薄水溶液、プラズマ

FToxid 酸化物（スラグ、ガラス、耐火物）

FTsulf 硫化物

FTsalt 塩

FTmisc 溶鋼（主成分が鉄、鉛など）、水溶液

FThall ホールエルー法の解析

FTOxCN
高温の酸・炭・窒化物（セラミックスな
ど）

FTfrtz 化学肥料

FThelg 希薄水溶液

FTpulp
パルプ製造工程で排出される黒液の
解析

FTlite アルミニウム合金・マグネシウム合金

FTdemo デモ用。ヘルプの例題で使用

BINS 二元系合金

熱力学データベース選択画面
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2.  ダウンロードとインストール
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ダウンロードとインストール

1. https://www.factsage.com にアクセス ⇒ 

FREE FACTSAGE DEMO &  EDUCATION VERSION をクリック
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ダウンロードとインストール

2. ダウンロードとインス
トール方法が説明さ
れている画面を表示

有効期限を延長する
方法、不具合の情報
等が記載される
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ダウンロードとインストール

3. ダウンロードするには
メールアドレスを開発元
へ連絡する必要がある。
クリックして申し込み画
面を表示
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ダウンロードとインストール

4. Privacy policy 

を確認してメール
アドレスを入力。
名前と所属も入力
していただけると開
発者の励みになる
だろう

5. Submit ボタンをクリックして
情報を送信
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ダウンロードとインストール

6. 開発元から英文メールが届く。メールに記載されているダウンロードリンクをクリッ
クするとダウンロードがはじまる。はじまらない場合は弊社にご連絡ください。ファイル
名は CD-FactSageEdu83.exe であり、ファイルサイズは 414 MB 程度である

7. ダウンロードした CD-FactSageEdu83.exe をダブルクリック
等で起動すると、Windows かまたはお使いのセキュリティソ
フトから警告されることがあるが、信頼して実行する
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ダウンロードとインストール

8. CD-FactSageEdu83.exe はインストールに必要なファイルがまとめられている
ファイルであり、最初に展開する必要がある。展開先のフォルダー（デスクトップで
よい）を入力して Install ボタンをクリック。インストール作業終了後、デスクトップ
に展開されたフォルダーは削除してよい
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ダウンロードとインストール

9. 展開終了のメッセージ。OK をクリック

10. 展開して現れたフォルダーを開いて Setup-FactSageEdu.exe を起動
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ダウンロードとインストール

11. ユーザーアカウント制御の画面が表示された場合、許可する
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ダウンロードとインストール

12. Next をクリック

13. インストール先（c:¥FactSageEdu）を
確認して Install をクリック
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ダウンロードとインストール

14. Finish をクリック

インストール中の画面。インストール
終了まで待つ。（PC の性能にもよる
が数分程度）

何かメッセージが表示されてインストー
ルに失敗した場合、セキュリティソフトを
一時的にオフにして再インストールを試
してほしい
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ダウンロードとインストール

15. デスクトップにショート
カットが表示されるので、
ダブルクリックして起動

青い画面が表示されれば成功。
Equilib で H2O の平衡計算をしてみてください
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3.  アンインストール
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アンインストール

■ アンインストールは Tools ⇒ Remove/Uninstall FactSage ... ⇒
Run Uninstall/Remove program ... をクリックして画面の指示にしたがう

※途中、右の画面が表示さ
れたら No to All をクリック



22

4.  熱力学平衡計算
（Equilib）
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Equilib

Equilib は系の平衡状態を予測するときに使うアプリ（モジュール）である。

Equilib は平衡状態で存在する可能性のある物質の中から 「平衡状態で存在す
る物質とその量」をギブズエネルギー最小化法により求める。

そのため Equilib の計算設定では「平衡状態で存在する可能性のある物質」を熱
力学データベースに収録されている物質から適切に選択する必要がある。

熱力学データベースに収録されている物質の数は、世界中の研究者が長年努力
してきたにも関わらず数千種類に限られている。熱力学データが無いなどの理由で
平衡状態で存在する物質を選択していない設定で計算すれば、当然ながら期待
外れの予測結果になる。

熱力学データベースは複数に分割されて提供されている。一つの純物質データ
ベースのみを使って計算する場合については物質の選択を気にすることはあまりな
いだろう。しかし複数の熱力学データベースを組み合わせて解析を行う場合は難し
くなる。Database Documentation をよく読み、熱力学データベースに詳しくなろう。
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Equilib の起動

Equilib の起動

• 平衡状態の予測（熱力学平衡計算）
• 純物質データベースと溶体データベースを使用
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Equilib の起動

Equilib を起動すると直前の設定を読
み込むか尋ねられる。
新規設定のときは「いいえ」を選択する

Equilib には 4 つの
ウィンドウがある。
(1) Menu

(2) Reactants

(3) List

(4) Results 

「いいえ」を選択すると熱力学データベースの
選択をそのままにするか尋ねられる。データ
ベースを変更するときは「いいえ」を選択する
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熱力学データベースの選択

Data Search をクリック

• 有機化合物 CxHy... 

の X の上限
• 溶体相の最小成分
の数
FACT 溶体は 2 とす
る。SGTE, TDnucl 

は 1 が推奨されて
いる。金属間化合
物が純物質データ
ベースになく溶体の
成分として扱われて
いる場合は 1 とする

データを含めるかどうか選択
• プラズマ
• FactPS の水溶液
• 25 ℃ のみしかないデータ
（現在この機能は無効）

使用するデータベースを選択

少なくとも 1 つ純物
質データベースを選
択しなければならな
い。緑色背景は純物
質のみ。無地はカッ
プルで提供されてい
るデータベース
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単位の設定

Units または T(C) P(atm) ... Vol(litre) をクリックして、Units 画面で設定
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H2O の平衡計算

H2O の平衡状態を解析する。Equilib の基本操作を学ぶ。

▼ 操作の流れ
(1) データベースの選択（純物質なので FactPS のみ）
(2) 単位の設定、物質の入力
(3) 温度、圧力の入力
(4) 平衡状態で存在する可能性のある物質を選択
(5) 平衡計算を実行
(6) グラフを作成する （別の例題で紹介）
(7) Excel に出力する （別の例題で紹介）
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H2O の平衡計算

1. 新規設定

■ 最初に H2O の平衡計算を練習して、Equilib の基本的な操作を学ぼう

2. 「はい」を選択

3. 熱力学データベースを新規に
設定するので「いいえ」を選択
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H2O の平衡計算

4. 平衡状態で混合気体、純物質の液相と固相が安定であると予想できる場合は、
純物質データベースを使って計算する。FactPS を選択する

5. OK をクリック
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H2O の平衡計算

7. 反応容器に投
入する物質を入力

6. 単位の設定

8. Next をクリック

初期条件の設定。平衡状態は初期条件によらない（例、初期条件が氷でも気体で
も 25 ℃、1 atm における平衡状態は水）ので、平衡状態を求める目的ではチェッ
クしない。反応前後の熱力学量の変化を計算するときはチェックして相（Phase）や
温度（T(C)）を入力する。初期条件を設定しない場合、結果に影響があるのは元素
の量のみ。H2O の代わりに H2 + 0.5 O2 と入力しても同じ結果になる

ストリームは同じ温度・圧力の物質
の集まり。初期条件を設定しない
場合、番号は 1 でよい

物質を追加するときは + をクリック
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H2O の平衡計算

10. 平衡状態で存在する可能性のある物質を選択。氷
は存在しないと予想して液相と気相を選択する。気相は 

ideal （理想気体）と real （実在気体のモデル）のどちら
かを選択する。real のデータは一部の物質のみ利用で
きる。25 ℃, 1 atm では理想気体の仮定は悪くないので 

ideal を使用する。real を選択してもよい

9. 温度が 25 ℃ と 150 ℃ の場合を一度に計算。圧力は 1 atm に設定。平衡
状態におけるエンタルピー（Product H(J)）は計算して求めたいので空白

Menu Window

（メニュー画面）

溶体相の表示。
FactPS に溶体相はな
いので表示されない混合気体の成分を選択

する場合は gas を右ク
リック ⇒ 次ページ

データがあればモル
体積を考慮(高圧で
重要)・物性値の推算
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H2O の平衡計算

gas を右クリック
H2O(g) のみを考慮する場合

平衡計算に考慮しない物質を設定する場合の例
• 準安定相の挙動を調べる場合。Fe-C 系では、安定になるまで長時間必要な 

C(s) を外して、準安定相の Fe3C(s) の挙動を調べることがある。
• 有効温度範囲外の温度で計算する場合（気体の成分は間引かないことが多い）
• 選択した化学種の数が Equilib で扱える限界の数（7000）を超える場合。
• 特定の物質（例、混合気体）のギブズエネルギーを求めたい場合。特定の物質
のみ選択する
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H2O の平衡計算

11. normal を選択して Calculate をクリック

12. 出力形式を選択。
弊社では ChemSage フォーマットを推奨
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H2O の平衡計算

温度、圧力を変更して再計算する場合は Final Conditions を設定して Calculate 

をクリックする。ただし奇妙な設定をしたときに警告メッセージが表示されないので、
慣れるまでは Menu 画面に戻って再計算するほうが適切かもしれない。黄色い設
定領域を隠すときは Final Conditions ⇒ Hide をクリックまたは閉じるボタンをク
リックする。本資料では結果の見やすくするために隠している
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H2O の平衡計算

平衡状態では水
が 1 mol 存在し
ている

系全体（水）の
熱力学量と体積
（既定では気体
の体積）

計算設定

気相の活
量。全圧
の意味で
はない

フガシティー

モル分率。この例では、圧力が変
わり気相が安定になったときのモル
分率と一致する。一致しない物質、
条件もある。気体の量が 0 のときに
結果を利用することはまずない

安定相の熱力学量

25 ℃ の場合

活量（ラウール基
準）。安定相は 1
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気相の活量
（ラウール基
準）。安定相
なので 1

H2O の平衡計算

150 ℃ では水
は存在しない

150 ℃ の場合

混合気体の組成。
H2O 以外はほと
んど 0

理想気体（gas_ideal）なので、
FUGACITY は分圧の意味である。
分圧 = モル分率 × 全圧（1 atm）

混合気体の構
成元素の組成

温度など
条件を変
えて計算
する場合
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H2O の平衡計算

● 練習 1

H2O は 2500 ℃, 1 atm で混合気体になります。H2(g) の分圧を予
測してください。

● 練習 2

(mole) 2 H2O + 0.79 N2 + 0.21 O2 について、 25 ℃, 1 atm におけ
る平衡状態を計算して、H2O(g) の分圧を予測してください。

● 練習 3

Ag2O を加熱すると、Ag と O2 に分解することを中学生のころに学習
したかたもいらっしゃると思います。平衡計算で、そのとおりに分解す
るか確かめてください。何 ℃ くらいに加熱すればよいでしょうか。
ヒント： 温度の入力ボックスに「50 250 10」と入力してみてください
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H2O の平衡計算

● 練習 4

水は電離します。25 ℃、 1 atm における H2O の平衡状態について
水溶液を考慮した計算をして、電離の様子を調べてください。
ヒント： データベース選択の画面で、aqueous species にチェック

● 練習 5

アルゴンガスは電離します。(mole) 0.99 Ar + 0.01 H2O について、
10000 K, 1 atm における平衡状態を予測して、電離の様子を調べ
てください。
ヒント： データベース選択の画面で gaseous ions にチェック

● 練習 6

25 ℃, 1 atm における以下の物質のギブズエネルギーを求めてくだ
さい。すべて 1 mol とします。
H2O(s), H2O(liq), H2O(g)



40

H2O の平衡計算（水の加熱）

■ 25 ℃, 1 g の水に 1 cal の熱量を与えたときの系の組成と温度を求める

4. Initial Conditions にチェックを
入れて初期条件を設定。
水なので liquid を選択する

2. 単位を設定

5. Next をクリック

1. 新規設定 ⇒ はい ⇒ いいえ ⇒ FactPS を選択

3. 反応種を入力
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H2O の平衡計算（水の加熱）

6. 平衡状態で存在する可能性のある相や物質を選択

7. 圧力の設定

10. Calculate をクリック

8. 与える熱量（Delta H）の設定

9. 予想される系の温度を入力
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H2O の平衡計算（水の加熱）

系に与えた熱量

系の温度

初期状態における
系のエンタルピー

平衡状態における
系のエンタルピー

設定した ΔH になるまで
何回も温度を変えて計
算している。負荷の高い
計算であり、正しい値が
求まらない場合がある
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H2O の平衡計算（水の加熱）

● 練習 7

1 g の水（0 ℃）と 1 g のお湯（90 ℃） を混ぜると何 ℃ になるか計
算してください。実験中、外部と熱のやりとりはないとします。

（ヒント： 入力物質に別々の温度を設定する場合は物質の入力画面
で Stream を水とお湯で別の値にします。）

● 練習 8

1 g の氷（0 ℃）と 1 g のお湯（90 ℃） を混ぜると何 ℃ になるでしょ
うか。

● 練習 9

40 ℃ の 8 畳部屋が 790 mol N2+ 210 mol O2 の乾燥空気で満た
されている。10 mol の水（40℃）を蒸発させると室温は何 ℃ になる
でしょうか。N2 と O2 の Stream を同じにすると N2 と O2 の混合気体、
別にすると、N2 と O2 が混ざらずに共存しているという意味になります。



アルミニウム合金の平衡計算

Al-Mg-Si 系（A6101）の挙動を予測する。

FTlite データベース用いて解析する。FTlite データベース
には、アルミニウム合金、マグネシウム合金、チタン合金の
データが収録されている。
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■ Al-Mg-Si 系の平衡計算。アルミニウム合金なので FTlite を使って解析する

アルミニウム合金の平衡計算

1. Database Documentation を起動して FTlite ⇒ (pdf) general description ... 

を開く。どのような系が解析できるか、また FTlite の使い方を確認しておこう
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アルミニウム合金の平衡計算

6000 番台の アルミ
ニウム合金の解析が
可能

Si は青色で記載されて
いて Al-Mg-Si 系は評
価されていることが確認
できる。よって、この系
は解析可能であり高い
予測精度を期待できる



47

アルミニウム合金の平衡計算

データベースの使い方を確認
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アルミニウム合金の平衡計算

Al-Mg-Si 系は SGTE で計算可能であることがわかる。FTlite については三元系状
態図が「計算状態図データベース」に収録されていないので、この画面では確認で
きない。Mg-Si, Al-Si, Al-Mg の二元系部分系が計算できることは確認できる

2. Al-Mg-Si が含まれる計算状態図を検索
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アルミニウム合金の平衡計算

3. 新規設定 ⇒ はい ⇒ いいえ ⇒ FTlite を選択

7. Data Evaluation をクリックして二元系部
分系のデータが最適化されているか確認

6. 反応種を入力

4. + をクリックして入力場所を作成

5. 単位を設定
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アルミニウム合金の平衡計算

すべて Top quality なので悪くない状況。三元系は Documentation ⇒ general 

description で確認する

Unary は元素

溶融合金のモデルは修正擬化学モデル

溶融合金のモデルは Bragg-Williams 近似
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9. 平衡状態で存在する可能性
のある物質を選択。FTlite につ
いては最初はすべての溶体相
を選択して計算してみよう。自
動選択されない相（例、FTlite-

prB2）は準安定相であり、安定
相を求める計算では選択しない。
溶体相のオプションは自動的に
選択される。I オプションは二相
分離を、J オプションは三相分
離を考慮する設定。どちらも計
算負荷が大きくなる。変更する
場合は「+」の列を右クリックする

アルミニウム合金の平衡計算

8. Next をクリック

すべての溶体相を選択する場合
Select ⇒ Select all solutions 
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アルミニウム合金の平衡計算

10. 温度と圧力を入力。「200 700 10」は 

200 ℃から 700 ℃ まで 10 ℃ 刻みの意味

11. normal + transitions を選択して Calculate をクリック。transitions は相変
態点または相転移点を探してその条件で計算させるオプション。探し出せない場
合は温度刻み幅を小さくしたり、FactPS の Ar を微量追加して再計算してみる
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アルミニウム合金の平衡計算

12. 出力フォーマットを選択。
ChemSage フォーマットがおすすめ

13. 26 ページ以降
を表示する場合
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アルミニウム合金の平衡計算

700 ℃ の場合

左から、相の成分・
各成分の量・質量
分率・活量。活量
の基準はラウール
基準。溶融合金の
成分 Al を基準に
したときの Al の活
量は 9.8465E-01 

である

溶体相の名前。
#1(;#2) は相分離し
ていないことを表す

相の量 相の活量
1 のときは安定相

計算条件
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アルミニウム合金の平衡計算

Al_fcc_A1(s1) を基準にしたときの Al  の活量は 9.3095E-01 である。
溶融合金の成分である Al を基準にしたときの Al の活量は 9.8465E-01 であった

700 ℃ （つづき）
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アルミニウム合金の平衡計算

700 ℃ （つづき）

系全体（すなわち溶融合金）の熱力学量。V は既定では気体の体積な
ので 0 となる。FTlite は一部の物質については体積データをもっている。
体積データを使った計算例は後述する
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アルミニウム合金の平衡計算

595.66 ℃ で融け始める

相転移が起こる
温度で
• 相の活量： 1 

• 相の物質量： ほ
とんどの場合 0

FCC_A1 は固
溶体（合金）。
副格子モデ
ルでモデル化
されている
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アルミニウム合金の平衡計算

200 ℃ の場合

aC1 相は 2 副格子モ
デルでモデル化されて
いる。構成元素のモル
分率から、Al は無視で
きるほど小さく、Mg:Si 

= 0.66667:0.33333 = 

2:1 である。
よって aC1 相は近似
的に Mg2Si(s) とみな
せる。端成分の質量分
率からもイメージできる
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アルミニウム合金の平衡計算（グラフの作成）

1. Plot Results... を選択

2. X 軸、Y 軸を設定

3. 表示する物質の選択
（次ページ）
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アルミニウム合金の平衡計算（グラフの作成）

相（(s), (g) など）が表示される

単位の変更

選択した物質をクリア

4. すべての安定相（55 個の計算結果のいずれか
で活量が 1 になった相）を選択する。プロットする
物質を一つづつ選んでもよい。安定な物質の物質
量に注目して Gram (max)（= 55 個の計算結果
で最大値）が正の物質を選択してもよい
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アルミニウム合金の平衡計算（グラフの作成）

[page] にチェックを入れると、
最小値、最大値をとるページ
番号が表示される

5. OK をクリック
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アルミニウム合金の平衡計算（グラフの作成）

6. ラベルとグラフ画面の設定をして Plot をクリック
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アルミニウム合金の平衡計算（グラフの作成）

7. 枠と軸の設定画面を開いて編集 ※線上にラベルが表示されない
場合は、線を選択してから
Add ⇒ Text をクリック（次ページ）
※文字を { } で囲むと下付きで表
示される（例： SiO{2} ⇒ SiO2）
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アルミニウム合金の平衡計算（グラフの作成）

(1) 線をクリックして選択
⇒ 色が変化する (2) Add ⇒ Text 

を選択

(3) 文字の位置、色、大きさなどを設定して OK 

をクリック。テキストを { } で囲むと下付きになる
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アルミニウム合金の平衡計算（グラフの作成）

8. 見やすくなる
ように仕上げる。

• ラベルの移動：
マウスの右ボタ
ンでドラッグ & 

ドロップ
• ラベルの色： ラ
ベルを右クリッ
ク ⇒ Edit

• 線の色： 線を
右クリック ⇒ 

Edit

溶融開始温度
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アルミニウム合金の平衡計算（Excel 形式に保存）

1. 結果画面（Results Window）で 

Save or Print As… をクリック

■ 計算結果を Excel 形式で保存する

2. Excel Spreadsheet を選択して
Spreadsheet setup ... をクリック
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アルミニウム合金の平衡計算（Excel 形式に保存）

4. クリックして
項目一覧を表示
⇒ T(C) を選択

6. クリックして
項目一覧を表示
⇒ grams を選択 7. Select ... をクリック

して化学種の選択（次ページ）

5. 表示項目数を設定
（化学種の量）

3. 表示項目数を設定
（系に関する量）
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アルミニウム合金の平衡計算（Excel 形式に保存）

化学種の選択

8. Excel に保存する物
質を選択。安定相の
み選択をしたい場合は 

Select all stable 

phases をクリック

溶体相の構成元素のこと
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アルミニウム合金の平衡計算（Excel 形式に保存）

9. OK をクリック

10. OK をクリック

11. 保存先を入力して Save をクリック。
Open をクリックして開いてもよいだろう。
ファイル名の拡張子を .xlsx にしてもよい。
保存先のフォルダー名とファイル名は英
数字にすること

出力する化学種が多いときは、行と列
を入れ替えることがある
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アルミニウム合金の平衡計算（Excel 形式に保存）

12. 保存したファイルを開いて確認



物性値の推算、高圧の平衡状態

熱伝導率や粘度などの物性値を推算するときは、Menu 画面で use 

V and phys. property data を選択する。データが収録されている
一部の物質については、体積データが考慮された平衡計算が行わ
れて、熱伝導率や粘度などの物性値が出力される。

高圧条件では、固相と液相について、体積に関係するデータ（密度、
熱膨張率など）を考慮すべきである。

数 atm では体積の影響は非常に小さい。体積に関係するデータを
考慮しないほうが一般的には解は求まりやすいので、考慮しないこと
のほうが多いだろう。
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物性値の推算、高圧の平衡状態

■ アルミニウム合金の物性値を推算する

2. 単位を設定

3. + をクリックして、入力場所を作成

5. Next をクリック

1. 新規設定 ⇒ はい ⇒ いいえ ⇒ FTlite を選択

4. 反応種を入力
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物性値の推算、高圧の平衡状態

6. 平衡状態で存在する可能性のある物質を選択する。今は Liquid と FCC-A1 

が存在することが事前の計算でわかっているとして、この 2 つのみ選択する

8. 温度、圧力を設定

7. 体積データを考慮する。
物性値を推算する

9. Calculate をクリック



74

物性値の推算、高圧の平衡状態

1 atm の場合

溶融合金の粘度と表面張力

体積データの有無
• V: 有（圧力依存性が考慮されている）
• 無印: 有（圧力依存性は考慮されてなく一定値）
• o: 無

体積、密度
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物性値の推算、高圧の平衡状態

3000 atm の場合

高圧になると、体積は小さくな
り、液相の量は小さくなる。

⚫ 練習
assume molar volumes of 

solids and liquids = 0 で計算
して、1 atm と 3000 atm で結
果が同じになることを確認して
ほしい
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5. 状態図計算
（Phase Diagram）
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Phase Diagram

Phase Diagram は、熱力学データベースを使って、多成分系の平
衡状態図を作成するモジュール（アプリ）である。

Equilib と同様に、Database Documentation を参考にして、「平衡
状態で存在する可能性のある物質」を適切に選ぶこと。

溶体相の選択にあたっては、Database Documentation が参考に
なる。

Phase Diagram を使うと、4 成分系以上の状態図（成分量を固定
する必要あり）、擬二成分系の状態図、水溶液の状態図、エンタル
ピー変化の状態図等、さまざまな状態図を作成できる。
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Phase Diagram

Phase Diagram の起動

• 状態図計算
• 純物質データベースと溶体データベースを利用
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Phase Diagram の起動

Phase Diagram を起動
すると、直前の設定を読
み込むか尋ねられる。
（インストール直後は除く）
新規設定のときは、
「いいえ」を選択する

Phase Diagram には 

4 つのウィンドウがある。
(1) Menu 

(2) Components

(3) List

(4) Results 

前の画面に戻るときに
クリック
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熱力学データベースの選択

Data Search をクリック

• 有機化合物 CxHy... の X の上限
• 溶体相の最小成分の数

FACT 溶体を使うときは 2 とする

データを含めるかどうか選択
• プラズマ
• FactPS の水溶液
• 25 ℃ のみしかないデータ
（現在この機能は無効）

使用するデータベースを
選択。少なくとも 1 つ純
物質データベースを選
択しなければならない。
緑色背景は純物質のみ。
無地はカップルで提供さ
れているデータベース
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単位の設定

Units または T(C) P(atm) ... Vol(litre) をクリックして、Units 画面で設定
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CaO-SiO2 系の状態図

酸化物系の状態図計算で、Phase Diagram に慣れよう。
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CaO-SiO2 系の状態図

■ CaO-SiO2 系の計算状態図を作成する

1. 酸化物系なので FToxid が適していると予想できる。
Database Documentation を起動して FToxid ⇒ general description を確認

CaO, SiO2 を含む系で最適化されているので 

FToxid が適していると判断できる
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CaO-SiO2 系の状態図

計算したい物質の計算状態図と、計算に用いた熱力学データベースを検索するこ
とができる。データベース選択の目安になる。ただし最適化されたデータがあっても
計算状態図は収録されていない系がある。general description を参照すること

CaO, SiO2 を含む系で検索

FToxid が適切なことがわかる。 これらの状態図は FToxid で計算されていることが
確認できる。多成分系を計算するときは、各 2, 3, 4 成分の部分系のデータの有
無を確認する。多成分からなる相のギブズエネルギーは各 2, 3, 4 成分部分系の
データから計算される

FToxid の計算状態図の一覧
からも確認できる
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CaO-SiO2 系の状態図

2. 新規設定

3. 「はい」を選択

4. 熱力学データベースを新規に設定
するので「いいえ」を選択



86

CaO-SiO2 系の状態図

5. FToxid を選択する

6. OK をクリック
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CaO-SiO2 系の状態図

9. 物質を入力

Components Window

7. 単位を設定

8. + をクリックして
入力場所を追加

10. Next をクリック
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CaO-SiO2 系の状態図

13. Variables 枠内のグレーの領域または 

Variables をクリック（次ページ参照）

Menu Window

A-Slag-liq を選択すると自動的に
I オプション（二相分離する可能性
がある場合は必須）が設定される

12. 平衡状態で
存在する可能性
のある純物質を
選択。
溶融スラグ相を
選択するので 

pure liquids は
選択しない

11. 平衡状態で存在する可能性
のある溶体相を選択

溶体相の表示
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CaO-SiO2 系の状態図

13-1. X-Y 座標系
を選択

13-2. Next をクリック

13-3. 温度を Y 軸に設定
（範囲： 600 ～ 2600 ℃）

13-4. 圧力を 1 atm に
設定

13-5. SiO2 のモル分率を
X 軸に設定（範囲： 0～1）。
モル% で設定したい場合は
両辺を 100 倍する 13-6. OK をクリック

Variables
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CaO-SiO2 系の状態図

14. Parameters をクリック

15. 表示する内容の設定

Parameters

17. OK をクリック

16. ラベルや線種の設定。show ‘(s)’ の (s) は純物質固相
の意味。表示させたほうがわかりやすいだろう
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CaO-SiO2 系の状態図

18. Calculate をクリック 計算結果

19. ラベルモード。
左クリックしてラベ
ルを貼り付ける。右
クリックで貼り付け
ると 90°回転する

ラベルを削除する
場合は、normal 

edition モード（ペ
ンのボタン）にして、
ラベルを選択して 

Delete キーを押す
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CaO-SiO2 系の状態図（Manipulate and Refresh）

■ 共晶点（相平衡）を表示させる

phase equilibria ボタンをクリック

相平衡が表示される
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CaO-SiO2 系の状態図（Phase Equilibrium モード）

2. 平衡計算したい場所をクリック

3. クリックした場所の座標が表示
される。必要なら座標を数値で入
力して OK をクリック

■ 状態図の上の任意の点における平衡状態を調べる

1. Phase Equilibrium モード
に切りかえる
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CaO-SiO2 系の状態図（Phase Equilibrium モード）

ChemSage フォーマットがおすすめ。
設定直後は変化しない。次回から
ChemSage フォーマットで表示される

入力した座標での平衡計算が実行される
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Al-Mg-Si系の状態図

三角形の等温断面図を作成するのに必要な基本操作を
紹介する。
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Al-Mg-Si 系の状態図

1. Database Documentation を起動して FTlite ⇒ (pdf) general description ... 

を開く。どのような系が解析できるか、また FTlite の使い方を確認しておこう

■ Al-Mg-Si 系の状態図を作成する。アルミニウム合金なので FTlite を用いる



97

Si は青色で記載されて
いて Al-Mg-Si 系は評
価されていることが確認
できる。よって、この系
は解析可能であり高い
予測精度を期待できる

Al-Mg-Si 系の状態図
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Al-Mg-Si 系の状態図

データベースの使い方を確認
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Al-Mg-Si 系の状態図

Al-Mg-Si 系は SGTE で計算可能であることがわかる。FTlite については三元系状
態図が計算状態図データベースに収録されていないので、この画面では確認でき
ない。Mg-Si, Al-Si, Al-Mg の二元系部分系が計算できることは確認できる。すべ
ての組み合わせの部分系が計算できなければ三元系の予測精度は低いだろう

2. Al-Mg-Si が含まれる計算状態図を検索
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Al-Mg-Si 系の状態図

6. 物質を入力

Components Window

4. 単位を設定

5. + をクリックして
入力場所を作成

7. Next をクリック

3. 新規設定 ⇒ はい ⇒ いいえ ⇒ FTlite を選択
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Menu Window

Al-Mg-Si 系の状態図

10. Variables をクリック
（次ページ参照）

9. 平衡状態で存在する可能性のある純物質を選択

8. 平衡状態で存在する可能性のある溶体相を選択
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10-1. 三角形の状態
図

10-3. 温度と圧力を設定

10-4. 三角形の頂点 A, B, C に
対応する物質を選択
A: Si, B: Al, C: Mg

Variables

Al-Mg-Si 系の状態図

順番に注意
#1: A-Corner

#2: C-Corner

#3: B-Corner

10-2. Next をクリック

10-5. OK をクリック
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Al-Mg-Si 系の状態図

計算結果11. Calculate をクリック

12. ラベルモードになって
いることを確認して、ラベ
ルを貼り付けたい場所を
クリック
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Al-Mg-Si 系の状態図

13. クリックすると、
平衡している相を
結ぶ直線（タイライ
ン）が表示される。

タイラインの表示は
Manipulate and 

Refresh Window 

の機能を使う方が
ずっと楽である。次
ページに示す

タイラインモード
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Al-Mg-Si 系の状態図（Manipulate and Refresh）

■ タイラインを表示する別の方法

1. 線の多さを選択して
all domains をクリック

2. 正常に表示されない領域は 

1 domain ボタンをクリックして
表示されない領域をクリック



Fe-O2 系の状態図 / エリンガム図

Fe-O2 系の状態図を計算する。平衡
状態で存在する可能性のある物質は
純物質のみと考えて FactPS のみを
用いる。

鉄の酸化物が固溶体として表現され
ているデータベース（FToxid）を用い
ると酸化物についてより信頼性の高
い解析を行うことができる。

一般的によく知られているエリンガム
図では溶体・固溶体は考慮されてい
ない。ここでは FactPS のみを使って
解析しよう。

「エリンガムダイアグラム」 ウィキペディア日本語版 2024 年 4月 

30日 16:20(日本時間) 現在での最新版を取得。
https://ja.wikipedia.org/wiki/%E3%82%A8%E3%83%AA%E3

%83%B3%E3%82%AC%E3%83%A0%E3%83%80%E3%82%

A4%E3%82%A2%E3%82%B0%E3%83%A9%E3%83%A0
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1. 新規設定 ⇒ はい ⇒ いいえ ⇒ FactPS を選択

Fe-O2 系の状態図 / エリンガム図

■ Fe-O2 系の状態図を計算する。縦軸を RTln(p(O2)) とする

4. 物質を入力

2. 単位を設定

3. + をクリックして
入力場所を追加

5. Next をクリック
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Fe-O2 系の状態図 / エリンガム図

7. Variables 枠内のグレーの領域また
は Variables をクリック（次ページ参照）

6. 平衡状態で存在する可能性のある物質を選択
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Fe-O2 系の状態図 / エリンガム図

7-1. X-Y 座標系を選択

7-4. 温度と圧力の設定

7-5. RTln(p) を設定する。気体なので分圧 p と表示される

7-2. エリンガム図の縦軸である RTln(a) を選択
して、設定する個数を 1 にする。a は活量の意
味。組成は設定しないので 0 である

7-6. OK をクリック

7-3. Next 

をクリック
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Fe-O2 系の状態図 / エリンガム図

計算結果

8. Calculate をクリック
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1. 新規設定 ⇒ はい ⇒ いいえ ⇒ FactPS を選択

Fe-O2 系の状態図 / エリンガム図

■ Fe-O2 系の状態図を計算する。縦軸を p(O2) とする

4. 物質を入力

2. 単位を設定

3. + をクリックして
入力場所を追加

5. Next をクリック
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Fe-O2 系の状態図 / エリンガム図

7. Variables 枠内のグレーの領域また
は Variables をクリック（次ページ参照）

6. 平衡状態で存在する可能性のある物質を選択
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Fe-O2 系の状態図 / エリンガム図

7-1. X-Y 座標系を選択

7-4. 温度と圧力の設定

7-5. log10(p) を設定する。気体なので分圧 p と表示される

7-2. 酸素分圧を設定するので log10(a) を選
択して、設定する個数を 1 にする。a は活量の
意味。組成は設定しないので 0 である

7-6. OK をクリック

7-3. Next 

をクリック



114

Fe-O2 系の状態図 / エリンガム図

計算結果8. Calculate をクリック
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サンプルの表示

Phase Diagram アプリの計算設定方法はサンプルで確認
しよう。
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サンプルの表示

2. FTOxCN を選択

3. サンプルの表示。
シングルクリックでプレビュー、
ダブルクリックで設定と状態
図の読込み

1. File ⇒ Directories ...
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あとがき

FactSage Education には多くのドキュメントが含まれています。

実用的な計算事例がスライドショーのサンプルにあるのでご覧ください。

▼ サンプルの表示方法 

FactSage メイン画面の Information ⇒ FactSage Applications ...⇒各サンプル

FactSage が内部でどのような計算をしているか知りたい場合は、Information から
開くことができる FactSage-TEACH で勉強するとよいでしょう。

平衡計算が複数回必要な解析（例、平衡計算結果から気体を取り出し、それを冷
やしたらどうなるか）は FactSage では困難な場合があります。このような解析には、
専用のツール（ChemSheet, KilnSimu）、または C 言語 や Python 等の平衡計
算ライブラリー（ChemApp）が便利です。

皆様が FactSage Education を用いて熱力学平衡計算の世界に興味を持ってい
ただけたのなら望外の喜びです。

RCCM FactSage チーム
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